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LESSON SKILL MATRIX

Skill Exam Objective Objective Number

Adjusting Slide Orientation and Size Change slide size. 1.5.1

Customizing Audience Handouts Modify the handout master.

Print handouts.

1.3.5

1.6.3

Choosing Slides to Display Hide and unhide slides.

Create custom slideshows.

1.2.3

1.7.1

Rehearsing and Recording a Slide Show Rehearse slide show timing. 1.7.3

Setting Up a Slide Show Configure slideshow options. 1.7.2

Working with Presentation Tools Present a slide show by using Presenter View. 1.7.4

Packaging a Presentation for CD Delivery Export presentations to other formats. 5.2.5

ADJUSTING SLIDE ORIENTATION AND SIZE

Orientation refers to the direction material appears on a page when printed. A page printed 
in landscape orientation is wider than it is tall, like a landscape picture that shows a broad 
panoramic view. A page printed in portrait orientation is taller than it is wide, like a portrait 
picture that focuses on a single, upright figure. Slide size is expressed as a ratio of height to 
width, also called aspect ratio. You can choose Standard (4:3) or Widescreen (16:9) or you can 
set up a custom slide size with your choice of ratios. 

Take Note Do not confuse slide size with resolution. Resolution refers to the number of pixels that makes 
up a slide display on the monitor and is applicable only in Slide Show view. Resolution is config-
ured in the Set Up Show dialog box.

Selecting Slide Orientation

By default, slides are displayed so they are wider than they are tall (landscape orientation). You 
might want to change the orientation of a presentation for a special case, such as to accommodate 
large graphics that have a portrait orientation or to print slides at the same orientation as other 
materials. You can easily change this orientation by using the Slide Size dialog box or a Ribbon 
command. In this exercise, you will practice changing slide orientation.

You cannot mix landscape and portrait orientations in a single presentation the way you can in a 
word processing document. All slides in a presentation must have the same orientation. However, 
if you need to display one or more slides in a different orientation, you can create a secondary pre-
sentation with the different orientation and then provide links between the main presentation and 
the secondary one. You can easily click the link during the slide show to jump to the secondary 
presentation, and then click another link to return to your main presentation.
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Presentation materials such as notes pages and handouts print in portrait orientation by default 
because this orientation allows the most efficient placement of slide images and text on the page. 
Adjusting orientation for these materials allows you to fit more information across the longest axis 
of the page—a plus if you have a lot of notes for each slide.

STEP BY STEP Select Slide Size and Orientation

GET READY. Before you begin these steps, make sure that your computer is on. Sign on, if 

necessary.

1. START PowerPoint, if it is not already running.

2. OPEN the Bid presentation from the data files for this lesson and then SAVE it as Bid 

Final.

3. Click the Design tab and then click the Slide Size button. A menu opens.

4. Click Widescreen. The height/width ratio for all slides in the presentation changes to 

widescreen (16:9). 

5. Click the Slide Size button again, and then click Custom Slide Size. The Slide Size 

dialog box opens (see Figure 11-1). Note the current width and height measurements at 

the left side of the dialog box.

Take Note $e measurements for Width and Height in the Slide Size dialog box are in inches, but an inch 
on a monitor can look different depending on the monitor’s size and display resolution. $e main 
concern is the ratio between the height and the width here. For example, the ratio of 13.333” by 
7.5” expressed as a fraction is 16/9, the standard for widescreen. Because widescreen monitors are 
the standard these days, that is the default size of a PowerPoint presentation. 

6. Open the Slides Sized For drop-down list and examine the available options for slide 

sizes. Click 35mm Slides, and note the width and height settings. 

7. Click Portrait in the Slides area.

8. Click OK. A dialog box opens asking whether you want to maximize the size of your 

content or scale it down.

9. Click Ensure Fit. The slide’s orientation and aspect ratio has changed.

10. Reopen the Slide Size drop-down list and then click Standard (4:3).

11. When prompted whether you want to maximize or ensure fit of the content, click 

Maximize. The slides return to their original 4:3 dimensions. The content has been 

somewhat distorted in size due to your choices of Ensure Fit and Maximize in steps 9 

and 11 respectively.

12. CLOSE Bid Final without saving your changes to it.

PAUSE. LEAVE PowerPoint open to use in the next exercise.

Figure 11-1

Slide Size dialog box
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If you do not find a suitable size for a specific need, you can create a custom slide size. Adjust the 
width and height as desired in the Slide Size dialog box to create the custom slide size. 

Besides allowing you to set slide size and orientation, the Slide Size dialog box lets you choose 
the starting number for slides in a presentation. $is option is useful if you are combining several 
separate presentations into one comprehensive slide show.

CUSTOMIZING AUDIENCE HANDOUTS

You can help your audience follow a presentation by giving them handouts, which show small 
versions of the slides arranged in various ways on a page. Handout layouts are controlled by a 
Handout Master, as slide appearance is controlled by the Slide Master. You can customize the 
Handout Master to create your own handout layout. You can also export handouts to Microsoft 
Word, where you can customize them further. We don’t cover that in this section but you can 
experiment with it yourself by clicking File, Export , and then selecting Create Handouts. 

Customizing the Handout Master

You can customize the layout of the Handout Master, which controls how handouts are formatted 
in PowerPoint. You can add text boxes to it, enable or disable certain placeholders, and format 
those placeholders. In this exercise, you customize the Handout Master in several ways.

You can create handouts that show one, two, three, four, six, or nine slides on a page. If you make 
changes to any of these layouts, the changes are reflected on all other layouts. 

You cannot adjust the position or size of the slide placeholders in the Handout Master. You can, 
however, adjust both size and position of the Header, Date, Footer, and Page Number placehold-
ers. You can also choose to hide some or all of these placeholders by deselecting their check boxes 
in the Placeholders group on the Handout Master tab.

$e Handout Master tab allows you to change both slide orientation and handout orientation, 
using buttons in the Page Setup group. To further modify the appearance of handouts, you can 
change theme colors and fonts (but not the current theme) and apply a different background style. 
You can format the Header, Date, Footer, and Page Number placeholders like any text box or 
placeholder using Quick Styles, fills, or outlines.

Note that you can also customize the Notes Master in many of the same ways that you customize 
the Handout Master. Click the Notes Master button on the View tab to display the Notes Master 
tab. $e Notes Master allows you to adjust the size and position of the slide image as well as other 
placeholders on the page.

STEP BY STEP Customize the Handout Master

GET READY. REOPEN the Bid Final presentation that you created at the beginning of the 

previous exercise.

1. Click the Insert tab, click Header & Footer, and then click the Notes and Handouts tab.

2. Set up headers and footers as follows:

a. Click to mark the Date and time check box, and make sure the Update automatically 

option is selected.

b. Click to mark the Header check box and then type the header A. Datum Corporation.

c. Click to mark the Footer check box and then type the footer No Job Is Too Big for A. 

Datum.

d. Click Apply to All.
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3. Click the Design tab, click Slide Size, and then click Custom Slide Size.

4. Under the Notes, Handouts & Outline heading, click Landscape, and then click OK.

5. Click the View tab and then click the Handout Master button in the Master Views 

group. The Handout Master view opens with the header and footer you supplied in step 

2.

Take Note If the file is stored on a server, you might see a message about edits made in this view being lost 
when saved to the server. Click Check Out to continue.

6. Click the Slides Per Page button in the Page Setup group, then click 3 Slides. The 

Handout Master displays the layout used to show three slides across the width of the 

page.

7. Click the Insert tab, click Text Box, and then draw a text box above the center slide 

placeholder of the same width as the placeholder (see Figure 11-2).

Text box

8. Type Center City Bridge Project in the text box.

9. Change the font size of the text box text to 16, apply bold formatting, change the 

color to Dark Blue, Text 2, and then center the text. Adjust the size of the text box as 

necessary to display the text on one line.

10. Click the outside border of the header placeholder in the upper-left corner of 

the master, hold down Shift, and then click the date, footer, and page number 

placeholders.

11. Change the font size to 14 pt, apply bold formatting, and then change the color to Dark 

Blue, Text 2. 

12. Click the Handout Master tab and then click the Close Master View button to exit 

Handout Master view.

13. Click the File tab and then click Print. Open the Full Page Slides button’s list and then 

click 3 Slides. Your customized handout master should resemble the one previewed in 

Figure 11-3.

14. Click the Next Page arrow to see that the text box you added displays on each page of 

the handouts.

15. Click the Print button to print the handouts. 

Figure 11-2

Add a text box to the 
Handout Master
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Select the 3 Slides handout here Company Name Next Page 

Take Note In some classrooms, printing is limited or unavailable. Check with your instructor as needed to 
make sure it is okay to print a multiple-page document in your classroom.

16. SAVE the presentation.

PAUSE. LEAVE the presentation open to use in the next exercise.

CHOOSING SLIDES TO DISPLAY

You might want to present only a portion of the slides you have prepared on a specific sub-
ject. You can select the slides to display by hiding slides or by creating a custom slide show.

Hiding Selected Slides 

You can omit slides from a presentation by hiding them. Use the Hide Slide button or com-
mand to hide a slide so it will not appear during the presentation. In this exercise, you hide 
a slide. 

STEP BY STEP Hide a Slide

GET READY. USE the Bid Final presentation that is still open from the previous exercise.

1. Go to slide 2 and then click the Slide Show tab.

2. Click the Hide Slide button in the Set Up group. The slide is shaded in the Slides pane 

at the left and the slide number is surrounded by a box with a diagonal bar across it.

3. Press F5 to start the presentation from slide 1. 

4. Click the mouse button and notice that slide 2, Our Mission, does not display. You go 

directly to slide 3, The Bid Team.

5. Press Esc to stop the slide show.

PAUSE. LEAVE the presentation open to use in the next exercise.

Figure 11-3

Preview of the customized 
handout
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Creating a Custom Show

Here we look at how to create custom shows to customize presentations for different groups 
using slides from a single presentation. A comprehensive year-end corporate review presentation, 
for example, might include information on the company as a whole as well as on the operations of 
each department. You could show all of the slides to the board of directors and use custom shows 
to present to each department the general company statistics and the information specific to that 
department. Custom shows allow you to focus attention on the material most relevant to a specific 
audience. In this exercise, you will create a custom show that contains a subset of the slides in the 
main presentation.

You select the slides for a custom show in the Define Custom Show dialog box. Add slide titles 
from the main presentation to the custom presentation. You can adjust the order in which the 
slides display in the custom show: Use the up and down arrows to the right of the Slides in custom 
show list to move a selected title up or down in the list.

STEP BY STEP Create a Custom Show

GET READY. USE the Bid Final presentation that is still open from the previous exercise.

1. Click the Slide Show tab, if necessary, and then click the Custom Slide Show button in 

the Start Slide Show group.

2. Click Custom Shows. The Custom Shows dialog box opens.

3. Click the New button. The Define Custom Show dialog box opens.

4. In the Slide Show Name box, type Corporate Information.

5. Click the check box for slide 2 in the Slides in presentation list and then click the Add 

button to place this slide in the Slides in custom show list.

6. Add slides 4, 5, and 6 to the custom show list. Your dialog box should look like Figure 

11-4.

Take Note $e brackets around slide 2’s number indicate it is a hidden slide.

7. Click OK and then click Show. The custom show starts with the second slide you added 

(the first slide, slide 2, is still hidden). If you were to unhide slide 2, it would also be 

unhidden in this custom show.

8. Click the mouse button to proceed through the slides of the custom show until the 

show ends.

9. SAVE the presentation.

PAUSE. LEAVE the presentation open to use in the next exercise.

Take Note When you add slides to the Slides in custom show list, they are renumbered in the list, but the slide 
numbers on the slides do not change.

Figure 11-4

Four slides have been added 
to the custom show`
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REHEARSING AND RECORDING A SLIDE SHOW

To make sure that your audience will have enough time to read and absorb the content on your 
slides, you can rehearse your delivery. When you rehearse a presentation, you read it just as if you 
were a member of the audience viewing the slides for the first time. Look at pictures, charts, and 
diagrams to read any information they supply. After you rehearse, you have the option of saving 
your timings to use during your presentation.

You cannot only record timings, but also narration (recorded audio commentary), annotations, 
and other features. If you cannot reach an audience in real time with your presentation, recording 
the presentation for later playback is an attractive option. As with timings, you can record the 
presentation from start to finish or re-record individual slides.

Rehearsing Timings

Rehearsing a presentation can help you set the timings for it. Slide timings are particularly im-
portant if you intend to show the slides as a self-running presentation that viewers cannot control. 
You should allow plenty of time for viewers to read and understand the content on each slide. 
(You will learn more about self-running presentations in the next section.) When you rehearse, 
you read the text on the slide out loud (or silently to yourself) to see how long each slide should 
appear onscreen. You can then choose to keep those timings after the rehearsal or discard them. 
In this exercise, you will rehearse timings for a presentation and record the timings for later use.

$e Rehearsal toolbar that displays when you rehearse slides shows you how much time you have 
spent reading the current slide as well as the elapsed time for the entire presentation. You can pause 
the rehearsal if necessary and then resume it when you are ready to continue. You can also choose 
to start the time again for a particular slide.

Note that saving your rehearsed times applies timings to the slide that allow PowerPoint to control 
the slides for you. $e presentation can run automatically without your having to click buttons 
to advance slides. If you have applied animations to slide objects, rehearsing will set the proper 
timing for those objects to display. 

You do not have to save the slide timings after rehearsal if you do not want PowerPoint to control 
the slides for you. You can tell PowerPoint not to save the timings, or you can deselect Use Tim-
ings in the Set Up group on the Slide Show tab to remove slide timings.

STEP BY STEP Rehearse and Record Timings

GET READY. USE the Bid Final presentation that is still open from the previous exercise.

1. On the Slide Show tab, click the Rehearse Timings button. The slide show starts from 

slide 1 and the Rehearsal toolbar appears in the upper-left corner of the screen (see 

Figure 11-5).

Next Slide

Elapsed time  
for current slide

Restart timing  
for current slide

Pause timing

Elapsed time for  
entire presentation

Figure 11-5

The Rehearsal toolbar appears 
in Slide Show view
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2. Read all the content on each slide, clicking the mouse button to display bullet items 

and advance slides. As you read, the timer is recording the time you spend. If you get 

interrupted, you can click the Pause button on the toolbar to pause.

3. When asked if you want to save the slide timings, click Yes. 

4. On the View tab, click Slide Sorter view. The presentation appears with the timing for 

each slide displayed below it.

5. On the Slide Show tab, mark the Use Timings check box if it is not already marked.

6. Press F5 to start the slide show again from slide 1. This time, let PowerPoint control the 

slides according to the rehearsal times you set.

7. After three or four slides have displayed, press Esc to end the slide show.

8. SAVE the presentation.

PAUSE. LEAVE the presentation open to use in the next exercise.

Clearing Timings

If you decide not to use automatic timings, you can easily clear all the timings from all slides at 
once. $e following exercise shows how to clear the timings for all slides.

STEP BY STEP Clear Slide Timings

GET READY. USE the Bid Final presentation that is still open from the previous exercise.

1. Click the Slide Show tab.

2. Click the arrow below the Record Slide Show button to open a menu, point to Clear, 

and then click Clear Timings on All Slides.

3. SAVE the presentation.

PAUSE. LEAVE the presentation open to use in the next exercise.

Recording an Entire Presentation

Recording a presentation helps you share your work remotely with people who might not be able 
to all assemble at a specific date and time to watch it live. $e audience members can view your 
recorded presentation at their convenience. Recording a presentation saves narration, annotations, 
and timings. It does not create a separate file as a recording; all those settings are saved in the 
regular PowerPoint file. In the following exercise, you record a presentation from start to finish.

Take Note If you want to save a separate file for distribution, consider making a video of the presentation.

Take Note In order to record narration, you will need a computer that has sound support and a microphone. 
You should set up and test the microphone ahead of time in Windows. In Windows 8, from the 
Start screen, type microphone and then click Settings. On the list of search results, click Set Up a 
Microphone and then follow the prompts. In Windows 10, click Start, type microphone, and then 
click the Set up a microphone link. Follow the prompts to prepare the microphone for recording. 

STEP BY STEP Record a Presentation from the Beginning

GET READY. USE the Bid Final presentation that is still open from the previous exercise.

1. On the Slide Show tab, click the Record Slide Show button. The Record Slide Show 

dialog box opens (see Figure 11-6).
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2. Make sure your microphone is ready.

3. Click Start Recording to begin the recording.

4. Click through the presentation, reading the text of the slides into the microphone at a 

moderate pace. The Rehearsal toolbar appears as you work through the presentation, 

the same as when rehearsing timings.

Take Note If you flub the narration when recording, keep going. You can re-record individual slides after you 
are finished.

5. When you reach the end of the presentation, click one more time to return to Normal 

view.

PAUSE. LEAVE the presentation open to use in the next exercise.

Re-Recording an Individual Slide

If you make a mistake in recording a certain slide, you can re-record it. In the following exercise, 
you re-record a single slide.

STEP BY STEP Record a Presentation from the Current Slide

GET READY. USE the Bid Final presentation that is still open from the previous exercise.

1. Display slide 8.

2. On the Slide Show tab, click the arrow under the Record Slide Show button and then 

click Start Recording from Current Slide. The Record Slide Show dialog box opens.

3. Click Start Recording.

4. Click to advance the bullet points on slide 8 at a moderate speed, while reading the text 

for slide 8 into the microphone. 

5. Instead of advancing to the next slide, press Esc to quit recording. PowerPoint returns 

to Normal view.

6. SAVE the presentation file.

PAUSE. LEAVE the presentation open to use in the next exercise.

SETTING UP A SLIDE SHOW

$e Set Up Show dialog box allows you to make a number of decisions about how slides 
display during a presentation. 

When setting up a slide show, you have the option of choosing a Show Type. $e choices are:

• Presented by a speaker (full screen) is the option to choose if the slides will be presented by 
a moderator (you or some other person) to a live audience. $e slides will display at full screen 
size.

Figure 11-6

The Record Slide Show dialog 
box
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• Browsed by an individual (window) is the option to choose if you are preparing the presenta-
tion for a viewer to review on his or her own computer. $e slides display within a window that 
contains a title bar with size/close controls. You can also choose to display a scrollbar to make it 
easy for the individual to scroll through the slides.

• Browsed at a kiosk (full screen) is the option to choose if you intend to have the presentation 
run unattended, with no moderator. $is option is a standard choice for trade shows or other 
venues where the slides can loop indefinitely for viewers to watch as long as they desire.

You can also configure the slide resolution for a specific monitor. ($e default monitor is Auto-
matic, which adjusts the resolution based on the monitor in use.) To set a specific resolution, select 
a monitor from the Slide Show Monitor drop-down list and then choose a resolution from the 
Resolution drop-down list.

Setting Up a Slide Show

$e following exercise walks you through the settings in the Set Up Show dialog box. Not all of 
these settings are applicable to the presentation being used for the example, but all are useful to 
know about because of the variety of presentations you might create in the future. In this exercise, 
you configure various settings that govern how a slide show runs in Slide Show view.

STEP BY STEP Set Up a Slide Show

GET READY. USE the Bid Final presentation that is still open from the previous exercise. 

1. SAVE the presentation as Bid Kiosk. 

2. On the Slide Show tab, click Set Up Slide Show. The Set Up Show dialog box opens.

3. Examine the settings in the Show type section, but do not make a change yet.

4. In the Show Options section, mark the Loop continuously until ‘Esc’ check box. 

Take Note $is setting is turned on automatically if you choose Browsed at a kiosk (full screen) as the show 
type.

5. Click to mark the Show without narration check box.

6. Click to mark the Show without animation check box.

7. Click the Pen color button and then click the purple standard color.

Take Note $e pen color is not important for this presentation because it will be self-running, but it is useful 
for future reference to know how to change it.

8. In the Advance Slides section, click the Use timings, if present option button if it is not 

already selected.

9. In the Show Type section, click Browsed at a kiosk (full screen). Several settings 

become unavailable when you choose this option, including Loop Continuously Until 

‘Esc’ (which becomes permanently on) and Pen Color. That is why this exercise does 

not change the show type until after you have tried out those settings.

10. In the Show Slides section, click the Custom show option button.

Take Note $e Corporate Information custom show is automatically selected because it is the only custom 
show in the presentation.

11. In the Multiple Monitors section, open the Slide show monitor drop-down list and then 

click Primary Monitor. The Resolution drop-down list becomes available.

12. Open the Resolution drop-down list and then click 800 x 600. The dialog box should 

look like Figure 11-7 at this point. 
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13. Click OK. The dialog box closes.

14. Examine the check boxes in the Set Up group on the Slide Show tab. Notice that the 

Play Narrations check box is cleared because of the check box you marked in step 5. 

Notice that the Use Timings check box is marked because of the option button you 

chose in step 8.

15. Clear the Show Media Controls check box. This setting is not directly applicable to this 

presentation. However, knowing how to turn on/off the onscreen controls for such clips 

is useful for future reference.

16. SAVE the presentation and then CLOSE it.

PAUSE. LEAVE PowerPoint open to use in the next exercise.

SOFTWARE ORIENTATION

Presentation Tools in Slide Show View

When in Slide Show view, presentation tools appear in the bottom left corner of the screen. $ey 
are faint until you point at them; then they become bright icons that you can click to open menus. 
In Figure 11-8 the Menu button is active and its menu is open.

Previous

Next

Pen

Zoom

Menu

Figure 11-7

The Set Up Show dialog box 
with custom settings applied

Figure 11-8

The presentation tools
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You can also display a navigation menu by right-clicking anywhere on the slide. $e right-click 
menu contains an additional command, Pointer Options, which opens the same menu as the Pen 
button in the presentation tools.

If you have a second monitor available, you can optionally choose to display Presenter View on 
the monitor that the audience does not see. Presenter View contains many tools for controlling 
the presentation behind-the-scenes and provides a quick look at any speaker notes you might have 
included in the presentation file (see Figure 11-9).

Next slideSpeaker notesCurrently displayed slide

Pen Zoom Previous Menu Next Show notes in larger 
or smaller font size

Black/Unblack  
the screen

See All Slides

 

WORKING WITH PRESENTATION TOOLS

PowerPoint offers a number of presentation tools you can use during a presentation to control 
the display of slides and mark directly on the slides if desired. You can use keyboard commands, 
mouse clicks, presentation tools, or menu commands to control the presentation. You can select 
from several marking options and colors to annotate your slides during the presentation.

Moving Through a Presentation

$ere are many ways to move through a presentation’s slides. You can simply click to move 
from start to finish, ignoring any hidden slides. If you want to jump around to other slides 
that are not in the default sequence, you can use the navigation menu, keyboard shortcuts, 
or other techniques. In this exercise, you will practice moving through a presentation.

PowerPoint provides many methods so that you can use the tools that are most comfortable for 
you to go forward, backward, or to a specific slide. Table 11-1 summarizes the most popular nav-
igation options in Slide Show view.

Figure 11-9

Presenter View
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If you have chosen the Browsed by an individual (window) show type in the Set Up Show dialog 
box, the presentation tools at the lower-left corner of the screen do not display and you cannot 
use the mouse button to go to the next slide. You can use the keyboard options to go to the next 
or previous slide, or you can right-click the slide and select Next to move forward or Previous to 
move backward through slides.

Table 11-1 

Navigation Options in  
Slide Show View

Action Keyboard Mouse Right-click menu Presentation tools

Show the next 

slide or animation

N 

Enter 

Spacebar 

Page down 

Right arrow

Left mouse 

button.

Right-click, then click 

Next.

Next button.

Show the 

previous slide or 

animation

P 

Page up 

Backspace 

Left arrow

n/a Right-click, then click 

Previous.

Previous button.

Go to the next 

slide if hidden

H n/a n/a n/a

Go to the last 

slide viewed

n/a n/a Right-click, then click Last 

Viewed.

Menu button, then click 

Last Viewed.

Go to a specific 

slide

Press G and use the arrow keys to move 

the highlight to the desired slide and 

then press Enter to display it. 

OR 

Press Ctrl+S for the All Slides dialog box, 

click the desired slide, and then click Go 

To. 

OR 

Type the slide number and press Enter.

n/a Right-click, then click See 

All Slides, then click the 

desired thumbnail.

See All Slides button, then 

click the desired thumbnail.

End show Esc n/a Right-click, then click End 

Show.

Menu button, then click 

End Show.

Zoom in on a part 

of the current 

slide

+ to zoom in (press again to zoom in 

more) - to zoom out (press again to 

zoom out more)

Right-click 

to return to 

regular 

viewing 

after 

zooming in.

Right-click, then click 

Zoom In. Click an area of 

the slide to zoom in on. 

Drag to move the 

zoomed area. 

Zoom button. Click an area 

of the slide to zoom in on. 

Drag to move the zoomed 

area. 

Get Help 

(command 

summary)

n/a n/a Right-click, then click 

Help.

Menu button, then click 

Help.

STEP BY STEP Move through a Presentation

GET READY. REOPEN the Bid Final presentation you worked with earlier in this lesson.

Take Note An easy way to reopen Bid Final is: click the File tab, click Open, and then click the Bid Final file 
at the top of the list of recent files.

1. Make the following changes to the presentation’s setup so that it is configured to be 

used by a live speaker:
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a. You should have done this earlier but if it’s not done, click the Slide Show tab, click 

the down arrow under the Record Slide Show button, point to Clear, and then click 

Clear Timings on All Slides.

b. Click the down arrow under the Record Slide Show button, point to Clear, and then 

click Clear Narrations on All Slides.

c. Click the Set Up Slide Show button, and in the Show Slides section, make sure All is 

selected (not Custom Show).

d. In the Show Type section, click Presented by a speaker (full screen).

e. Open the Slide show monitor drop-down list and then click Automatic.

f. Click OK.

2. Click the From Beginning button to start the presentation from slide 1.

3. Move the pointer on the slide until you can see the presentation tools in the lower-left 

corner of the screen (see Figure 11-8).

4. Click the Next button (the right-pointing arrow). The next slide displays.

5. Click the Previous button (the left-pointing arrow at the far left of the tools). Slide 1 

redisplays.

6. Right-click anywhere on the slide to display the presentation shortcut menu, and then 

click See All Slides. Thumbnail images of the slides appear. Notice that slide 2 is darker 

than the others because it is hidden.

7. Click the Back arrow in the upper left corner to return to the slide shown and then press 

Page Down to display the next slide.

8. Move the mouse pointer to display the presentation tools and then click the Zoom 

button (looks like a magnifying glass). A large rectangular shaded area appears, 

attached to the mouse pointer.

9. Move the mouse pointer so the shaded area is over the photo and then click to zoom in 

on the photo. After looking at the photo, right-click to zoom out again.

10. Click the Menu button in the presentation tools (the rightmost button) to display a 

menu (see Figure 11-8) and then click Last Viewed. The slide you previously viewed 

(slide 1) displays.

11. Right-click the screen again and then click End Show on the presentation shortcut 

menu to end the presentation.

PAUSE. LEAVE the presentation open to use in the next exercise.

Using Presenter View

Presenter view, as you saw in Figure 11-9, provides an interface for controlling a live show. You can 
use it on another monitor as your slides display in Slide Show view on the monitor or projector that 
the audience sees. You can display Presenter view even if you do not have two monitors. $is gives 
you a chance to practice working with Presenter view in advance of your presentation, regardless 
of the hardware you have to practice with. In this exercise, you will enter Presenter view and learn 
about some of its tools and features.

STEP BY STEP Use Presenter View

GET READY. USE the Bid Final presentation that is still open from the previous exercise.

1. On the Slide Show tab, click From Beginning to start the presentation from slide 1. 

2. Right-click anywhere on the slide and then click Show Presenter View on the menu. 

Presenter view appears. The current slide appears in the large pane on the left. 

Beneath it are icons that represent some of the same presenter tools as in Slide Show 

view. These icons were pointed out in Figure 11-9. The next slide appears in the smaller 

pane on the right. If this slide contained any speaker notes, they would appear in the 

lower-right corner.

3. Click the Next arrow (right-pointing arrow) at the bottom of the screen. The 

presentation advances to the next slide.
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4. Below the notes pane, click the Make the text smaller button. The note text appears 

smaller (see Figure 11-10).

Elapsed time Restart the timer End Slide Show Smaller note text appears here 

Pause the timerShow Taskbar 

Black or Unblack Slide Show Make the Text Larger button Make the Text Smaller button

5. Above the current slide, note the timer, which has been recording how much time the 

presentation has been running. Click the Pause the timer button next to it. The timer 

stops and the button turns to a Resume the Timer button (right pointing arrow).

6. Click the Restart the timer button (the button to the right of the Resume the Timer 

button). The timer resets and the timer resumes counting.

7. Click Show Taskbar. The taskbar appears at the bottom of the screen. Click Show 

Taskbar again to turn it off. Showing the taskbar during a presentation can be useful 

because it enables you to jump out to some other application temporarily.

8. Click the Black or unblack slide show button below the current slide. The image of the 

current slide appears black and appears that way on the audience’s screen too.

9. Click the Black or unblack slide show button again to restore the current slide’s image 

to the audience’s screen.

10. Click End Slide Show to end the presentation.

PAUSE. LEAVE the presentation open to use in the next exercise.

Annotating Slides with the Pen or Highlighter

As you proceed through a presentation, you might want to pause to emphasize certain points. 
You can annotate (write) directly on a slide with the annotation tools in PowerPoint. You can 
control these tools, including setting the color and width of the onscreen pen, via the Pen menu 
in the presentation tools. Various pen types, thicknesses, and colors are available. In the following 
exercise, you create ink annotations during a slide show.

PowerPoint offers three different annotation pen options: Laser Pointer, Pen, and Highlight-
er. $e Laser Pointer does not leave marks on the slide at all. $e Pen leaves marks where 
you drag it, about the same thickness as an ink pen. $e Highlighter leaves a colored swath 
where you drag it that is semi-transparent, so it does not obscure content. You can change 
the ink color for any of these pen types.

Figure 11-10
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$e Black Screen and White Screen options allow you to replace the current slide with a black or 
white screen that you can use for annotations or to cover the current material if you want to keep 
it under wraps while you are discussing some other issue.

STEP BY STEP Annotate Slides 

GET READY. USE the Bid Final presentation that is still open from the previous exercise.

1. Uncheck Use Presenter View on the Slide Show tab if necessary. 

2. Press F5 to start the presentation from slide 1, type 7, and then press Enter. Slide 7 

appears. 

3. Move the mouse to display the presenter tools, click the Pen icon (see Figure 11-11), and 

then select Pen from the menu. The pointer changes to a small, round pen pointer.

4. Right-click the slide, point to Pointer Options, and then click Ink Color. Then click 

Orange in the Standard Colors palette.

5. Press the space bar until the Site Preparation bullet point appears and then use the pen 

pointer to circle the value for site preparation, $1,125,500.

6. Press the B key on the keyboard. The screen is blacked out so you can annotate without 

the distraction of the slide material.

7. Use the pen pointer to draw a large U.S. currency symbol ($) in the middle of the slide.

Take Note While a pen pointer is active, you cannot use the mouse button to advance slides.

8. Press the B key again. The slide background is restored and the annotation disappears.

9. Press Esc on the keyboard. The arrow pointer is restored.

10. Click or press Enter twice to go to slide 8.

11. Press the space bar until the Weather and Overhead power lines bullet points appear, 

click the Pen button in the presentation tools, and then click Highlighter. Drag the 

highlighter pointer across the Weather bullet item to highlight it.

12. Click the Pen button and then click Erase All Ink on Slide. The highlight you added is 

removed.

13. End the slide show. When asked if you want to keep your annotations, click Keep.

14. SAVE the presentation.

PAUSE. LEAVE the presentation open to use in the next exercise.

When you reach the end of the presentation (or end it early), if you have created any annotations, 
you are prompted to either save or discard them. If you save them, they are saved on the slide as 
ink, which is similar to a drawing you might do with the Shapes tool. 

Figure 11-11

Choose the Pen pointer



Lesson 11222

Editing Ink Annotations

You can move and delete individual annotations on slides as you would any other graphics and 
you can also manage ink with the Ink Tools Pens tab. In the following exercise, you edit an ink 
annotation in Normal view and add a new annotation there.

STEP BY STEP Edit Ink Annotations

GET READY. USE the Bid Final presentation that is still open from the previous exercise.

1. In Normal view, display slide 7 and then click the orange circle you drew as an 

annotation.

2. Click the Ink Tools Pens tab to examine the options available (see Figure 11-12).

 

3. Click the Color button to open its palette, and then click Light Green. The selected 

annotation changes color.

4. Click the Thickness button to open its menu, and then click 3 pt. The selected 

annotation increases in thickness.

5. Click the More button in the Pens group to open a gallery of pen styles (see Figure 

11-13).

6. In the Built-In Pens section, click Red Pen (1.0 mm). Notice that the selected annotation 

does not change. These pen styles are for creating new annotations, not editing 

existing ones.

7. Drag to draw an underline beneath Site Preparation. 

8. On the Ink Tools Pens tab, click the Select Objects button to return to using the arrow 

pointer again.

9. SAVE the presentation.

PAUSE. LEAVE the presentation open to use in the next exercise.

Figure 11-12

Ink Tools Pens tab on the 
Ribbon

Figure 11-13

Gallery of pen styles
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PACKAGING A PRESENTATION FOR CD DELIVERY 

You might need to transport your presentation materials to another computer to run your 
slide show. $e Package for CD feature streamlines the process of packing all the materials 
you need to show the presentation even if PowerPoint is not installed on the other comput-
er. Even though this option has CD in the title, you can save the presentation on a Universal 
Serial Bus (USB) drive or on a folder on your computer to transfer to storage media later or to 
back up your presentation.

Packaging a Presentation for CD

$e Package for CD feature makes short work of packing all the files you need to show your slides, 
no matter what kind of system you have to use to run the show. In this exercise, you create a ver-
sion of your presentation on a CD that you can distribute to others.

Take Note Some earlier versions of PowerPoint packaged presentations to CD along with a PowerPoint View-
er utility. PowerPoint 2013 and 2016, however, take a different approach; they package presenta-
tions with a Web page on the CD. On this Web page is a link for downloading the PowerPoint 
Viewer if it is needed. If you plan on showing the presentation somewhere that does not have 
Internet access, make sure you download the PowerPoint Viewer ahead of time on the computer 
you will be working with if it does not have a full version of PowerPoint on it.

STEP BY STEP Package a Presentation for CD

Take Note You must have a writeable CD drive inserted in your system to complete this exercise. If you do 
not, or if you do not have a blank writeable CD disc available, skip this exercise.

GET READY. USE the Bid Final presentation that is still open from the previous exercise.

1. Insert a blank writeable CD disc in your writeable CD drive. If an AutoPlay box pops up, 

close it.

2. Click the File tab, click Export, click Package Presentation for CD, and then click 

Package for CD. The Package for CD dialog box opens. 

3. In the Name the CD box, type Bid, replacing the default name.

Take Note You can optionally add other presentations or other documents onto the same storage device to 
avoid using a separate device for each presentation. To add other presentations, you would click 
Add and select the presentations to include. You could then reorder them with the up and down 
arrow buttons in the dialog box. $is exercise packages only one presentation on CD, so it does 
not include these actions.

4. Click the Options button. The Options dialog box opens. Note that linked files are 

marked to be included and TrueType fonts will be embedded. Note that you can also 

optionally specify passwords to control access to the presentation(s) (see Figure 11-14).
Figure 11-14

The Options dialog box for 
packaging a presentation
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5. Click OK to accept the default settings and close the Options dialog box.

6. In the Package for CD dialog box, click Copy to CD.

7. A dialog box asks if you want to include linked files in your package. Click Yes. 

8. A message appears that the presentation contains comments or annotations, stating 

that these will not be included. Click Continue.

9. Wait for the presentation to be written to the CD. It might take several minutes. The CD 

ejects when finished.

10. In PowerPoint, a message appears stating that the files were successfully copied to CD 

and offering to copy the same files to another CD. Click No.

11. Click Close to close the Package for CD dialog box.

12. To test your new CD, reinsert the CD into your computer. If an AutoPlay box opens, 

click Run PresentationPackage.html. If no box opens, open File Explorer (or Windows 

Explorer if using Windows 7), click Computer, and then double-click the CD/DVD drive.

13. A Web page displays, showing a page that lists the presentations on the CD. (There is 

only one in this case.) A link also appears for downloading the PowerPoint Viewer. You 

do not need it on your PC since you have the full version of PowerPoint. 

Take Note Note that the name might appear as Bid%20Final because the space between the two words is 
treated as a non-breaking space in HTML.

14. Click the name of the presentation. Respond to any security warnings you might see in 

your Web browser. The presentation opens in PowerPoint, in Read-Only mode.

15. Click the File tab and then click Close to close the copy of the presentation that 

originated from the CD. (The original Bid Final presentation is still open.)

PAUSE. LEAVE the presentation open to use in the next exercise.

Take Note Package for CD works only with CDs, not DVDs. If you want to store a presentation on a DVD, 
you can save materials in a folder as described in the following section and then use your 
system’s DVD burning tools to copy the files to the DVD.

Packaging a Presentation to a Folder

With current computers being smaller and more compact, many students might not have 
a CD drive on their computer. In this case, you might want to distribute a USB drive to the 
student. You can use this same Package for CD option to save the files to a folder that you 
can then put on a USB drive. In addition, you can use this feature to archive presentations 
onto a CD, USB, or into folders for storage. $e packaging process pulls together all the files 
you need for a presentation, so your stored presentation provides an excellent long-term 
backup for your work. In this exercise, you package a presentation to a folder. 
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STEP BY STEP Package a Presentation to a Folder

GET READY. USE the Bid Final presentation that is still open from the previous exercise.

1. Click the File tab, click Export, click Package Presentation for CD, and then click 

Package for CD. The Package for CD dialog box opens.

2. Click Copy to Folder. The Copy to Folder dialog box opens. 

3. In the Folder name box, change the default name to Bid. 

4. In the Location box, change the path to the location where you store files for this 

lesson.

5. Click OK. 

6. A message appears asking if you want to include linked files in your package. Click Yes.

7. A message appears that the presentation contains comments or annotations and that 

these will not be included. Click Continue.

8. Wait for the presentation to be written to the new folder. It should occur almost 

instantaneously (unlike when making a CD). The folder opens in Windows when it is 

finished.

9. In the folder window, double-click the PresentationPackage folder to see what is inside 

it. The folder contains some graphics and support files that are needed to show the 

Web page. 

10. Close the folder window and return to PowerPoint. The Package for CD dialog box is 

still open.

11. Click Close to close the dialog box.

SAVE the presentation and then CLOSE the file. EXIT PowerPoint.
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Knowledge Assessment

Fill in the Blank

Fill in each blank with the term or phrase that best completes the statement.

1. Use the ____________ dialog box to change to a non-standard slide size.

2. You can set up a presentation to loop continuously until you press the ____________ key.

3. Use the ____________ toolbar to view timings as you rehearse a presentation.

4. When you ____________ slides, you use the pointer to draw or write.

5. The ___________ option allows you to save the presentation to easily distribute to others. 

Multiple Choice

Circle the correct answer.

1. A slide that is wider than it is tall is displayed in which orientation? 

a. Portrait

b. Column 

c. Picture 

d. Landscape 

2. Which of the following is not one of the standard placeholders on the Handout Master?

a. Date

b. Header

c. Page Number

d. Author

3. Which of the following options prevents a slide from displaying during a presentation?

a. Delete Slide

b. Hide Slide

c. Show/Hide Slide

d. Conceal Slide

4. Which of the following is not a way to advance to the next slide during a presentation?

a. Press Home

b. Press the spacebar

c. Click the left mouse button

d. Press Page Down

5. Which of the following is a quick way to restore the arrow pointer after you have used 

it for drawing?

a. Press End

b. Double-click the screen

c. Click the arrow pointer button in the presenter tools

d. Press Esc
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Projects

Project 11-1: Finalizing a Presentation and Creating Handouts

You are nearly ready to present the slide show for Blue Yonder Airlines. In this project, you will 
use the tools you have learned about in this lesson to finalize the presentation and create handouts.

GET READY. Launch PowerPoint if it is not already running.

1. OPEN the Airline presentation in the data files for this lesson and then SAVE it as 

Airline Final.

2. Click the Design tab, click the Slide Size button, and then click Standard (4:3). When 

prompted to scale the content, click Ensure Fit.

3. Click the Slide Show tab and then click the Set Up Slide Show button.

4. Choose the Presented by a speaker option and choose to have slides advance 

Manually. Choose Blue as the pen color. Click OK to accept the new settings.

5. Click the Insert tab, click Header & Footer, and on the Notes and Handouts tab, choose 

to display the date (update automatically), the header Blue Yonder Airlines, and page 

numbers. Click Apply to All to apply the setting to all slides.

6. Click the View tab and then click Handout Master to open Handout Master view.

7. Center the header text and date in their placeholders and right-align the page number 

in its placeholder. Close Handout Master view.

8. Hide the last slide in the presentation.

9. Click the File tab, click Print, and then set the following print options:

10. Choose to print handouts with four slides per page, in vertical order.

11. In the Slides settings, deselect the Frame Slides option.

12. In the Print All Slides settings, deselect the Print Hidden Slides option if it’s not already 

deselected.

13. Print the handouts.

14. SAVE the presentation and CLOSE the file.

Take Note In some classrooms, printing is limited or unavailable. Check with your instructor as needed to 
make sure it is okay to print a multiple-page document in your classroom.

PAUSE. LEAVE PowerPoint open for use in the next project.
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Project 11-2: Previewing a Presentation

In this project, you will run through the Airline Final presentation before delivering it to make 
sure you are familiar with content and how to display it during the slide show.

1. OPEN the Airline Final presentation you created in Project 11-1 and then SAVE it as 

Airline Final Check.

2. Hide slide 7.

3. Press F5 to view the presentation from slide 1.

4. Use the Next button in the presentation tools to move to slide 3.

5. Use the Previous button in the presentation tools to go backward to slide 1.

6. Right-click the slide to display the shortcut menu and use See All Slides to jump to 

slide 4.

7. Right-click the slide, click Pointer Options, and then select Highlighter.

8. Highlight the bullet items Caribbean and Scuba.

9. Restore the arrow pointer and press Esc to end the show. Choose to keep your 

annotations.

10. Rehearse timings for the presentation. When the presentation ends, save the slide 

timings.

11. Set up the slide show to use the slide timings you saved.

12. SAVE the presentation and then CLOSE the file.

EXIT PowerPoint.


